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HOW TO MAKE ACCESSIBLE PDFS 
If you are creating your own PDFs, when possible, start by creating an accessible Word 
document. (See How to Make Accessible Word Documents Handout for more information.) 
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By creating an accessible Word document first, there will be fewer errors that you need to fix 
once you convert it to PDF. 

 Pro Tip: Keep in mind that a Word Document tends to be the easiest format for 
screen reader technology to navigate through. So, it is best to provide information in 
a Word format whenever possible.  

ACCESSING THE TRAINING VIDEO AND POWERPOINTS 
This training handout was developed after attending a live three session training on how to 
make accessible PDFs that was presented by MSF&W in June 2021. Please feel free to access 
the video recordings of the training for additional information, as well as the PowerPoint 
Presentation Slides from the event.   

Helpful note: Bookmarks have been added to the video recording of the training provided by 

MSF&W. So, you can easily navigate through to discussion topics by clicking this icon  
located in the top left corner of the videos.  

TO START, YOU FIRST NEED ACCESS TO ADOBE ACROBAT PRO DC 
Very important step: In order to make edits and changes to a PDF you will need access to the 
Acrobat Pro DC version of Acrobat. Follow the steps at the following link to request access to 
Adobe Acrobat Pro DC from the Normandale IT Department (make sure to read the page very 
carefully): Faculty and Staff: Installing Adobe Software on your office computer   

SETTING UP YOUR TOOLBAR 
The information in this section will help you set up your Adobe Acrobat Pro Toolbar to help 
make the tools you need more readily available while making sure that a PDF is accessible to 
screen reader technology.  

THE TAGS PANE  
The tags pane is a main component to making sure a document is accessible. Here is how to 
set up the tags pane so you can access it quickly:  

1.  Click on the View Tab, Show/Hide, Navigation Panes, Tags: 

 

This action will result in opening up the tags pane: 

https://mediaspace.minnstate.edu/playlist/details/1_9ycnbjd1
file://EmpFs1/ShrDirs/Inet/Private/OSD/AT/How%20to%20make%20accessible%20documents%20handouts/tinyurl.com/PDFtraining
file://EmpFs1/ShrDirs/Inet/Private/OSD/AT/How%20to%20make%20accessible%20documents%20handouts/tinyurl.com/PDFtraining
https://normandale.teamdynamix.com/TDClient/1870/Portal/KB/ArticleDet?ID=78927
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2.  Make sure the Highlight Content feature is enabled/checked.  

Tags pane, Options, Highlight Content: 

 

ADDING THE ACCESSIBIL ITY  CHECKER TO YOUR TOOLBAR  
1.  Go to the Tools Tab. Under the protect & standardized section--Choose Accessibility--

depending on if you already have it saved to your toolbar, it will either say Add or Open 
underneath it.  

  

2. Any saved shortcut icons will be displayed on the far-right hand side of your screen: 
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3. Click on the accessibility icon now listed on the right-hand side of the screen: 

 

4. Add the Accessibility icon and the Reading Order icon to your upper toolbar for easy 
access at all times. This is accomplished by left-clicking on the desired item, then 
holding and dragging it to the upper toolbar. Important note: If you drag your item(s) to 
a blank area in the upper toolbar, it will not stay. Instead, you need to drag it between 
two items that are currently on the toolbar. 

 

5.  Now both Reading Order and Accessibility Check should appear on your top toolbar: 
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NOW THAT YOUR TOOLBAR IS SET UP, START BY RUNNING THE ACCESSIBILITY CHECKER 
The Accessibility Checker is an automated tool that's going to create a report of issues. It can 
be used as a guide as you work to repair your document so that it is accessible.  

OPTION 1 (WHICH IS  A BIT  QUICKER IN THE LONG RUN THAN OPTION 2)   
Start by adding the Action Wizard tool to your quick tools that will show on the far right-hand 
side of your screen when you open Adobe.  

1. Go to the Tools menu, scroll down to the Customize section, then choose Action Wizard:  

 
2. Click on the Action Wizard tool now 

added to your side toolbar: 

 

3. Click on Make Accessible: 

 
4. Click Start: 
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5. First, make sure the proper title for the document is listed. To do this, uncheck the Leave 

As Is button under the tile, then type the document title and click OK: 

 
6. The Recognize Text - General Settings should pop up. The setting should be preset to be 

marked as English (US), Searchable image, and 600 dpi. Click OK. A window should then 
run in the corner of your screen saying it is converting the pages to a searchable image.  

 
7. Next, a window will pop up asking if your document is intended to be a fillable form. If it 

does not, click No, Skip this Step:  

 
8. A Set Reading Language window will pop up. It is pre-set to English. So, unless you have a 

document that is primarily in a different language, click OK:  
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9. A pop-up will show, indicating that Adobe will now detect all figures in the document and 

display any figures that are missing alterative text. Click OK: 

 

10. A blue box will appear around the image/figure the document is checking; if alterative text is 
already added, it will be show in the white textbox space. Note: For the following example, 
which is a logo, simply type the name of the company: 
 

11. Use the arrow keys to move to the next image in the document: 

  

12. If an image is only decorative, check the box that says Decorative figure. Doing that will 
tell the screen reading technology to skip over that image.  

 
13. SAVE OFTEN! Click on both the save and close button in the set alt text window AND 

the save icon in Adobe This is the only way to not lose any alt text 
that you may add while working on the document at any one time!  

Note: If you do not have time to add alterative text to all the images at that specific time, click 
on Save & Close to run the final step of the Action Wizard. 

14. The Accessibility Checker window will pop up: 



8 
 

 

15. If an item is bold, that means there is an issue with that portion of the document. Click the 
arrow next to it to see what the issue is: 

 

16. The Accessibility Checker report will provide a status for each rule that is checked:  

 

OPTION 2  

1. Select the Accessibility Checker icon that is now located at the top of your toolbar:  
2. The Accessibility Checker Options window will pop up. 
3. Click Start Checking:  
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4. If an item is bold, that means there is an issue with that portion of the document. Click the 
arrow next to the item to see what the issue is. 

 

5. The report will provide a status for each rule that has been checked. 

 

Helpful Note: No matter how accessible you make a Word document, there are a few errors/fails 
and manual checks that will always pop up when you convert it to PDF. Those errors/manual 
checks include:  

The title error: 

How to fix it: First, right-click on the title error in the checker, then click fix:  
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Next, uncheck the Leave As Is button under the title, and then type the document title. Click 
OK. Note: You might have to resave your document in order for the title to show up as 
passed. 

 

Logical reading order: 

More information about logical reading order can be found in the section called: “The Reading 
Order tool is very important.”  

Color contrast  
You cannot really change color contrast in PDF. So, if you have the Word format of the 
document, make sure to change the color contrast before you switch the document over to a 
PDF. 

MAKING SURE ALTERNATIVE TEXT IS ADDED TO MEANINGFUL IMAGES IN A PDF 
For meaningful images that have essential information in them, make sure alternative text is 
added. Alterative text (commonly referred to as “alt text”) can be read by screen readers, and 
helps people who are blind or have low vision understand what images and other objects are in 
a document. Without alt text, an image on a page will simply read as “image.”  

HOW TO ADD IN ALTERATIVE TEXT 
1. Click on the Accessibility icon--instructions for adding the Accessibility icon to your most 

used tools can be found in the “Adding the Accessibility Checker to your toolbar” section 
of this document. 
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2. Click Set Alterative Text. This will allow you to do one of two things: (a) verify that 
existing alterative text is correct, or (b) add in alterative text to images that do not have it 
yet.  

 

3. A notification will pop up saying Acrobat will detect all figures in the document and 
display associated alterative text. Click OK:  

 
4. A blue box will appear around the image that the document is checking; and if alterative 

text has already been added, it will be shown in the white textbox space. Note: For the 
following example, which is a logo, simply type the name of the company. 

5. Use the arrow keys to move to the next image in the document: 

6. If an image is only decorative, check the box that says Decorative figure. Doing that will 
tell the screen reading technology to skip over that image.  

a.  
7. SAVE OFTEN! Click on both the save and close button in the set alt text window AND 

the save icon in Adobe. This is the only way to not lose any alt text 
that you may add while working on the document at any one time!  
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THE READING ORDER TOOL IS VERY IMPORTANT 
The Reading Order tool is fundamental in making sure your PDF is structured correctly. It is 
used to select and tag content correctly, mark items as decorative, and add data table headers. 
Terminology tip: In Adobe, a decorative image/alterative content is referred to as an Artifact, 
and an image is called a Figure. 

THIS IS  KEY:  MAKE SURE YOUR READING ORDER WINDOW IS  SET TO THE CORRECT SETTINGS 
1. Click on the Reading Order icon, which should now be located on your top toolbar: 

 
2. Make sure that: Show page content groups is checked, Structure types is marked, 

Show table cells is checked, and Show table and figures is checked: 

 

List of standard tag types in PDF   

WHAT THE READING ORDER TOOL LOOKS L IKE WHEN IT’S  ACTIVATED 
Once you have your Reading Order tool properly set up (see previous section), review your 
document to make sure it is set up correctly.  

Important note: When the Reading Order tool is activated, there should be gray boxes around 
the content in your pages.   See below example:  

 

Important Terminology when using the reading order tool: 

https://kbpdfstudio.qoppa.com/standard-pdf-tag-types/
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 An image that is essential and should be described should be labeled as a Figure.  
 The title of the document should be labeled as H1 (Heading 1). 
 The first section after the title should be marked as H2 (Heading 2).  
 Each paragraph should be labeled as P (Text/Paragraph).   
 An image that is only decorative should be labeled as a Background/Artifact. 

HOW TO UPDATE THE READING ORDER TAGS  
1.  Be aware that when the Reading Order tool is activated, your cursor will turn into a 

cross icon that looks like this:  
2. To update a tagged/reading order section in your document, drag and draw a box 

around the area that you want to update.  
Pro Tip: Draw the box a bit bigger then you actually need it. That will help make sure the 
Reading Order tool catches the full area that you wish to update. 

 
3. The area that you drew the box around will have purple boxes in the selected area 

 

Pro Tip: If you drew a box but did not get the full area that you wanted, click on an area 
of white space in the PDF and it should undo that last step so you can try again. 

4. Choose the Reading Order tag that you want. In this case, I want my selected area to be 
all under the same Text/Paragraph tag: 
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WHAT IF  A SECTION OF THE DOCUMENT IS  TAGGED INCORRECTLY?  
Sometimes, items in the PDF may be tagged incorrectly. In this example, a page is incorrectly 
structured so it reads from the far left to the far right, row by row:  

 

To fix this so that it is structured to read down each respective column before reading the next 
column, open your Reading Order tool and draw a box around each separate column:  

 

Your new selected area will show the selected words in purple. Next, choose Text/Paragraph: 

 

Doing that should break the section you want into its own paragraph to help make sure the 
material is read in the correct order. However, the second paragraph in this example will now 



15 
 
need to be relabeled. The easiest way to do this is to left-click on the P icon (circled in yellow 
below) so that the box turns blue, then right-click and choose Delete Selected Item Structure.  

 

WHAT IF  NO TAGS ARE ADDED TO THE ORIGINAL DOCUMENT?  
Sometimes when you go to check or update the reading order in a document, no tags pull up 
while you have the Reading Order tool open. If that is the case, it likely means that no tags have 
been added to that document yet.  

1.  Run the Accessibility Checker report, then click on the Tags icon, right-click where it 
says No Tags available, and click on Adds Tags to Document: 

  

2. A Recognition Report will pop up. You can DISREGARD that and EXIT out of it: 
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3. Now when you go back to your tags icon, the auto tags should show up and you should 

now be able to make changes using the Reading Order tool.  

WHAT IF  A PAGE IS  JUST SHOWING UP AS ONE LARGE “FIGURE”?  
Sometimes when you go to work on the reading order on a page, the whole page itself will be 
labeled as one big image (aka Figure), as in the following example:  

 

What appears to be the most accurate way to fix this is to first clear the page structure (see 
below example):  
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You will receive the following warning window. (This should only clear the structure for the 
current page you are on.) Click Yes: 

 

Then, using the Reading Order tool, you would draw boxes around each of the respective 
sections of the page and tag them accordingly. Using the above example, the new page 
structure should look like the following example:  
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VERIFYING LOGICAL READING ORDER IS  CORRECT  
Once the document is tagged, you need to manually verify that the tags are all placed in logical 
reading order. This is done by following these steps:  

1. Open up the Tags pane. Starting at the top of your tag list (aka your tag tree), use the 
down arrow on your keyboard to move through your document: 

 
2. As you move through the tag tree, an item that you are currently on will have a purple 

box around it.  

 

How to fix a tag that is not in the correct reading order 
As you are checking the items in the document’s tag tree (that is, using the down arrow on your 
keyboard to verify order), you may notice that some items are not in the correct reading order. 
There are two different ways you can fix that: 

Option 1 

Select the tag that you want to move, then drag and drop it to the location you want it to go to. 
(A little line will show to indicate where you are dragging the new tag to):  
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Option 2  

Cut and paste the tag in the location that you want it, by following these steps:  

1. Choose the tag that you 
want to move: 

 

2. Hit Ctrl X to cut (The tag will then 
gray out for a moment): 

 
3. Find the location that you want the tag to go below and hit Ctrl V to paste:  

+ hitting Ctrl V=  

VERIFYING THE LANGUAGE RULE  
In most cases, the language rule will actually show up as “passed” in the Accessibility Checker. 
A few times, this may not be the case is if the document is a scanned document or if it is a 
document that has more than one language in the text.  

Right-click on the language error, choose fix, and choose the language you want for the entire 
document: 

 

WHAT IF  A DOCUMENT HAS MORE THAN ONE LANGUAGE?  
To specify language in various sections of a document that has more than one language, follow 
these steps:  

1. Go back to your tag tree list, and find the section that is in a difference language. Right-
click that tag and choose Properties (See below example):   
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2. An Object Properties window will pop up. Choose the language that you want that tag to 
be, then click Close: 

 

TABLE HEADER ERROR 
1. With the Reading Order tool open, right-click within the table and choose Table Editor:  
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2. Doing that will cause your Reading Order tool to go to the background and turn your 

table cells pink, which will allow you to change the properties of each individual cell:  

 
*Helpful tip: In this example Fall, Spring, and Annual are all headers and they would be 
columns because you want the reader to read down each of those respective headers.  
Likewise, Tuition and Fees, Books and Supplies, and Total Direct Costs would be 
headers as well, but we would list those as rows because we want the reader to read 
that information left to right. 

3. Click on the cell that you want to update, and a light blue outline will appear: 

 
4. Right-click within that cell and choose Table Cell Properties: 

 
5. Then you can indicate if the cell is a header or a data cell. Next, indicate if that same cell 

is for either a row or a column, and then click OK. In this example, Fall is a header and it 
is a column cell: 
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6. Once you have made a change to a cell’s property, the cell will turn red.  

 
7. You will need to repeat this process for each cell that has a header in the table. Pro tip: 

If you have cells that will be set up with the same property settings, you can highlight 
more than one cell at a time and update the setting that way. 

 

TABLE SUMMARY RULE 
This rule can be ignored and skipped. Essentially what Acrobat is trying to have you do is 
manually add in a summary of each table. However, even if you followed the steps to add in a 
table summary, screen reader technology would not be able to read that information.  

TABLE REGULARITY ERROR  
The table regularity error will be displayed if your table does not have the same number of 
columns in each row or the same number of rows in each column (i.e. you merged some cells). 
In cases like this, you cannot use the Table Editor to fix this because the Table Editor does not 
allow you to add cells. You can fix the error by following these steps: 

1. In the Accessibility Checker, look under Tables. If you see the Regularity – Failed 
error, click the down arrow and click on the respective element. Doing that should 
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highlight the table in question. Next, right-click on that element and choose Show in 
Tags Panel.  

 
2. This should highlight that table for you and jump to the exact location in the tag tree 

where that table is located. Click the down arrow of that table.  

 
3. In this example, we know the issue is in the last row of the table, so find the last row in 

the table and the data cell next to the empty cell. Then right-click and choose New Tag. 
(See below picture for example.) 

 
4. A New Tag window will pop up. In the Type drop-down, change it to Table Data Cell.  
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5. In this case, leave the title blank and click OK.  

 

NESTED LIST ERRORS 
If you have sub categories in a list, this rule makes sure that the is structured correctly. Note: 
this error will likely not come up very often. 

1. To fix this error using your tag tree, find the location where the tag for the list starts, then 
find the section that you know will have sub sections below it. Right-click that tag and 
choose New Tag: 

 
2. The new tag window will pop up. In the Type drop-down choose List and click OK: 
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3. You will see that a new <L> tag has now been added. Select the two <L1> tags that are 

the sub sections for that list and drag and drop them onto the new <L> tag: 

 

APPROPRIATE NESTING FOR HEADINGS FAILED RULE 
The Appropriate Nesting for Headers - Failed error will pop up if Adobe believes that a header in 
the document could have been labeled incorrectly. Remember, headers provide a table of 
contents structure for screen reader technology, so we want to make sure the heading layout is 
correct.  

1. To fix this error, right-click on the element--the header in question will be highlighted in 
blue in the document--then click Show in Tags Panel: 

 

2. This will open the Tags tree, and the tag in question will be highlighted in blue:  

 
3. In this example, the heading label is currently listed as a Header 3, but it should be a 

Header 1 because it is the title of the document.  



26 
 

To fix the header, you could either use your Reading Order tool to relabel it as a 
Header 1; or you could right-click on the respective tag, choose Properties, and in 
the Properties menu change the Header 3 to a Header 1 and click Close. 

 
Note: After this step is complete, you may have to resave the document before this error will 
disappear from the Accessibility Checker report.  

VERIFY THAT THE BOOKMARKS ARE CORRECT  
Any document that is 21 pages or more will show up with a bookmark accessibility error that 
needs to be fixed.  

1. Click on the Bookmarks icon, and then after clicking on the item that has the red box 
around it in the following example, choose New Bookmarks from Structure:  

 

2. A pop-up window will indicate all the different tags structures that are in that document:  
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3. Choose H2 (aka Heading Level 2) and click OK: 

 
4. After hitting the down arrow next to the title of the document, you will see that Adobe has 

added in bookmarks to any area that is marked as a Heading 2 in this document: 

 

SPECIAL TOPICS 
COMPLEX TABLES 
A “complex data table” has cells that span multiple rows or columns, making the table irregular, 
such as the following example: 

 

Having such a table will bring up the table regularity rule error in the Accessibility Checker. So, 
you will have to check that data tables contain the same number of columns in each row, and 
the same number of rows in each column. (See the “Table Regularity Error” section of this 
document for more information.)  

If a table must remain complex, additional markup must be added in the Table Editor. 

1. For instance, for each header cell, you need to indicate the number of columns or rows 
spanned, if applicable.  

2. In addition, you need to give each header cell its own unique ID. Do that by right-clicking 
on the table and choosing Auto Generate Header Cell IDs:  
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3. Lastly, for each data cell, you need to list the ID of each associated header cell: 

 

Pro tip: If possible, rearrange or split the information into multiple tables to avoid it being 
irregular. Below is an example for making that kind of split:  
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LAYOUT TABLES  
Some documents may use a table layout to structure the information. When that happens, a 
screen reader is going to try and read the information as a table and not as logical tabular data.  

To fix this, completely open your Tags tree. Then, while holding the control key, select all the 
information that is actual information tags. In the following example <H1>, <H2>, <P>, <Figure> 
are selected (see below example): 

 

Then drag that to the top of your Tags tree. In this example, the Tags tree should now look like 
this:  
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Next delete all of the empty tags not needed in the document. In this example, those would be 
<Table>, <THead>, <TBody>, <TR>, <TH>, <TD>: 

 

FORMS 
There are a few things you should always double check when creating a form. The first is that 
each form field needs to be tagged, and the second thing is that each form field has what is 
called a tooltip. Pro tip: It is suggested that you run the Accessibility Checker on your document 
to fix any formatting errors (such as reading order), and save that updated document BEFORE 
you start working on converting it to a form.  

1. In Tools, go to the Forms & Signatures option, choose Prepare Form, and click Add. 
Note: After you do that once, this option should then show up in your Tools Shortcut 
Menu on the right-hand side of your Adobe Screen. Click Prepare Form: 

 
2. You then have to choose if you want to start from scratch or work on a document that 

you already created. In this example, we are working on a document already created, 
and we had it pulled up already. So, we click Start: 
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Adobe will automatically add in form fields where it believes they should go. You can add 
new text or edit old text (Add or Edit Text) by using the edit icon.  

 
You can also add in new check boxes or selection circles (radio buttons) by using the 
corresponding icons: 

 
3. Make sure each form field has a correct tool tip. (A tool tip needs to be a friendly human-

readable statement that explains to screen reader technology what this blank or 
checkbox is connected to.) Accomplish this by clicking on the respective form field, 
clicking Properties, and verifying that the tooltip says the text that is associated with that 
form field. Click Close. 

    
Helpful note: In this example, you would copy the paragraph next to its respective 
checkbox and paste it in as the tool tip.  
 

4. Next, you need to check that the tab order matches the logical reading order of the form. 
This is done on the right-hand side of the screen under “fields.” Click the down arrow 
next to the A to Z icon and verify that Tab Order is selected. Lastly, verify that the tabs 
are in the same order that someone should read the document in.  
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If needed, you can adjust tab order by dragging the fields (number 3 in the above 
screenshot) to the desired order.  

5. Use the Reading Order tool to tag the newly added form fields. 

 
6. Run Accessibility Check and repair issues as needed. 

SCANNED/IMAGE-ONLY DOCUMENTS:  ADDING OPTICAL CHARACTER RECOGNITION (OCR) 
Screen readers cannot read documents that were scanned by a copier as one large image on a 
screen. To fix this, use OCR (Optical Character Recognition) to add content to an image-only 
(scanned) document.  

Adobe may prompt you to OCR a scanned document when you open it. If it does not, you can 
scan and OCR a document by following these steps:  

1. In Tools, go to the Create & Edit section and choose Scan & OCR. Click the down 
arrow under Scan & OCR and choose Add. Note: After you do this once, this option 
should then show up in your Tools Shortcut Menu on the right-hand side of your Adobe 
Screen. From that menu, click Scan & OCR  
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2. Click the down arrow next to Recognize Text and choose In This File:  

 
3. Click Recognize Text: 

 
4. Click the down arrow next to Recognize Text again, and choose Correct Recognized 

Text: 

 
5. Adobe will flag any words that it might have gotten wrong when it ran OCR:  
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6. To fix this example, type in the correct spelling of “campus” and click Accept. (Adobe 
will then move on to the next text item that it needs you to confirm.) 

 
Pro tip: Handwritten signatures will likely come up as items that you need to fix. Instead 
of trying to fix them here, mark them as a Figure using your Reading Order tool and then 
add in alt text for the signature information (type the signed name).  

Helpful Note: If you want to be able to move around the document and “eyeball” it for possible 
text recognition errors, click on the Review recognized text box. Then you can scroll through 
the document and click on any area that you wish to fix. 

  

7. Next, you have to tag the document by running the Accessibility Checker Report, 
going to the Tags section and choosing Add Tags to Document. (Remember to 
disregard the report that will pop up after you do that.)  

 

8. Use the Reading Order tool to properly tag your document.  
9. Arrow through the tags to verify the correct reading order and fix as needed 
10. Run the Accessibility Checker one final time and fix any remaining errors in the 

document.  
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